Notices

© Agilent Technologies, Inc. 2014-2018

No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or translation into a foreign language) without prior agreement and written consent from Agilent Technologies, Inc. as governed by United States and international copyright laws.

Manual Part Number
M8313-90014 Rev. B

Edition
06/2018
Printed in Germany
Agilent Technologies
Hewlett-Packard-Strasse 8
76337 Waldbronn

Software Revision
This guide is valid for Secure Workstation for OpenLab CDS ChemStation Edition C.01.09.

Warranty
The material contained in this document is provided “as is,” and is subject to being changed, without notice, in future editions. Further, to the maximum extent permitted by applicable law, Agilent disclaims all warranties, either express or implied, with regard to this manual and any information contained herein, including but not limited to the implied warranties of merchantability and fitness for a particular purpose. Agilent shall not be liable for errors or for incidental or consequential damages in connection with the furnishing, use, or performance of this document or of any information contained herein. Should Agilent and the user have a separate written agreement with warranty terms covering the material in this document that conflict with these terms, the warranty terms in the separate agreement shall control.

Technology Licenses
The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with the terms of such license.

Restricted Rights Legend
If software is for use in the performance of a U.S. Government prime contract or sub-contract, Software is delivered and licensed as “Commercial computer software” as defined in DFAR 252.227-7014 (June 1995), or as a “commercial item” as defined in FAR 2.101(a) or as “Restricted computer software” as defined in FAR 52.227-19 (June 1987) or any equivalent agency regulation or contract clause. Use, duplication or disclosure of Software is subject to Agilent Technologies’ standard commercial license terms, and non-DOD Departments and Agencies of the U.S. Government will receive no greater than Restricted Rights as defined in FAR 52.227-19(c)(1-2) (June 1987). U.S. Government users will receive no greater than Limited Rights as defined in FAR 52.227-14 (June 1987) or DFAR 252.227-7015 (b)(2) (November 1995), as applicable in any technical data.

Safety Notices

CAUTION
A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.

WARNING
A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed beyond a WARNING notice until the indicated conditions are fully understood and met.
Secure Workstation for OpenLab CDS ChemStation Edition is a standalone workstation product that includes OpenLab CDS ChemStation Edition and OpenLab Server on a single computer. This guide contains information on working with the Secure Workstation for OpenLab CDS ChemStation Edition. It describes the settings required by 21 CFR Part 11, and provides information on the workflows using the Secure Workstation.

Table 1  Terms and abbreviations used in this document

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIC</td>
<td>Agilent Instrument Controller</td>
</tr>
<tr>
<td>CDS</td>
<td>Chromatography Data System</td>
</tr>
<tr>
<td>ChemStation</td>
<td>OpenLab CDS ChemStation Edition</td>
</tr>
<tr>
<td>Control Panel</td>
<td>OpenLab Control Panel</td>
</tr>
<tr>
<td>Microsoft Control Panel</td>
<td>Part of the Microsoft Windows operating system</td>
</tr>
<tr>
<td>Secure Workstation</td>
<td>Secure Workstation for OpenLab CDS ChemStation Edition</td>
</tr>
</tbody>
</table>

1 Introduction

This chapter introduces Secure Workstation for OpenLab CDS ChemStation Edition. It also describes the requirements of 21 CFR Part 11.

2 Basic Concepts

This chapter describes how to log in to Secure Workstation for OpenLab CDS ChemStation Edition, explains the user interface items and toolbars related to Content Management, and describes the main preference settings.
In This Guide ...

3 Working with Secure Workstation

This chapter describes the basic workflows for Secure Workstation for OpenLab CDS ChemStation Edition. There are four data-related workflows and two workflows for methods, sequence templates, or report templates.

4 Administration Regarding 21 CFR Part 11 Compliance

This chapter explains the purpose of 21 CFR Part 11 and how Secure Workstation for OpenLab CDS ChemStation Edition addresses the requirements of 21 CFR Part 11.

5 Filter and Search Options

This chapter provides an overview of the filter and search options for ChemStation data in the Content Management system.

6 Troubleshooting

The chapter gives some troubleshooting hints.
Contents

1 Introduction 7
   What is Secure Workstation? 8
   Using Secure Workstation 9
   Storage Model 15
   21 CFR Part 11 Compliance 16

2 Basic Concepts 17
   License Management 18
   Login and Lock Options 20
   User Interface in ChemStation Related to Content Management 22
   Preferences 27
   Remote Data Path as Sequence Parameter 38
   Compressed ChemStation File Formats 40

3 Working with Secure Workstation 41
   Transferring Data to or from the Repository 42
   Data-related workflows 43
   Workflows for Methods and Templates 53

4 Administration Regarding 21 CFR Part 11 Compliance 63
   Introduction to 21 CFR Part 11 65
   Overview of Configuration Steps Required for Part 11 68
   Audit Trails and Logbooks 69
   Security Policy 75
   Users/Groups/Roles Configuration 79
   ChemStation Administration Tool 84
   Electronic Signature 93

5 Filter and Search Options 95
   Using the Advanced Search 96
6 Troubleshooting 97
   Error messages at OpenLab Control Panel Startup 98
   Alerts and Error Messages at ChemStation Startup 99
   Content Management is not available after login 100
   Error Messages in the Queue Management 101
   Other Error Messages 103

7 Appendix 105
   Privileges in OpenLab Control Panel 106
1 Introduction

What is Secure Workstation? 8
Using Secure Workstation 9
   Overview of data-related workflows 11
   Overview of workflows for methods/sequence templates/report templates 13
Storage Model 15
21 CFR Part 11 Compliance 16

This chapter introduces Secure Workstation for OpenLab CDS ChemStation Edition. It also describes the requirements of 21 CFR Part 11.
What is Secure Workstation?

Secure Workstation for OpenLab CDS ChemStation Edition combines ChemStation Workstation and Content Management on one PC. It provides secure data storage for one LC/MSD, one CE/MSD, or up to two LC, GC, A/D, CE or SFC instruments.

Content Management allows you to easily store, organize, search, and review your ChemStation data. It automatically extracts searchable metadata from files, and provides powerful search capabilities.

In this document, the term *repository* refers to the Content Management database.
Using Secure Workstation

Secure Workstation for OpenLab CDS ChemStation Edition enables you to acquire, analyze, and securely store analytical data and reports on a single machine. You can store all your ChemStation files in the data repository:

- Methods (*.m)
- Sequence templates (*.s)
- Data files (*.d)
- Report templates for Intelligent Reporting (*.rdl)
- Reports (*.pdf, *.xls, *.doc, or *.txt)
- Library files (*.uvl)
- Column databases (*.mdb)
- Easy Sequence templates (*.est)
- Classic report templates (*.frp)

The storage of ChemStation data can be either automatic (that is, at the end of a single run or sequence) or manual. A manual storage is possible only when you already have a version in the system. The data can be downloaded later to ChemStation for review or reprocessing at any time.

Furthermore, Secure Workstation for OpenLab CDS ChemStation Edition offers features that enable users to comply with 21 CFR Part 11 and similar regulations for electronic records and electronic signatures:

- Mandatory login
- Configurable session locking
- Configurable ChemStation user roles and privileges
- Full data traceability through audit trails for methods and results
- Full data versioning
- A dedicated backup and restore procedure

For details, please refer to the Agilent Secure Workstation for OpenLab CDS ChemStation Edition Maintenance Guide.
**Naming Conventions**

Make sure you only use the following characters for ChemStation items such as file or directory names, names of sequence templates, or names of ChemStation methods:

A-Z, a-z, 0-9, _ (underscore), - (hyphen)

Check your names for leading or trailing blanks. They are not allowed, but are easily overlooked.

**NOTE**

If you use tokens, file names or directory names are automatically created based on information such as instrument names, operator names, or sample names. Make sure that these names follow the same naming convention.

**NOTE**

Automatically created file names may include specific characters for Front and Back injector location. These characters may be localized. They are valid even if they are not part of the characters listed above.

The following reserved device names cannot be used as the name of a file. Also avoid these names followed by an extension (e.g. Nul.txt):

- CON, PRN, AUX, NUL
- COMx (where x is a number from 1 to 9)
- LPT1x (where x is a number from 1 to 9)

**NOTE**

English, Japanese, and Chinese operating systems are used to test naming conventions. Agilent cannot give a support statement for non-English operating systems and their special characters.
Overview of data-related workflows

Workflow 1: Data Acquisition
1. Analytical raw data is acquired using ChemStation.
2. The raw data is automatically uploaded to the repository using the configured path definitions immediately after the single run/sequence is finished.
3. The data is added to the defined storage location.

Workflow 2: Data Acquisition + Review

Workflow 3: Reprocessing/Modifying + Upload

Workflow 4: Reprocessing + Import

Figure 1  Overview of data-related workflows

Workflow 1: Raw data acquisition and automatic transfer to the repository
Workflow 2: Offline revision during acquisition

1. Analytical raw data is acquired using ChemStation.
2. While the acquisition is still running, part of the data is changed using an offline ChemStation.
3. The raw data is automatically uploaded to the repository using the configured path definitions immediately after the single run/sequence is finished.
   The initial version of the data is added to the defined storage location.
4. After work in the offline ChemStation is finished, the changed data is also automatically uploaded to the repository.
   The second version of the data is added to the repository.

Workflow 3: Reprocessing data and automatic upload to the repository

1. Existing analytical data is loaded from the repository into ChemStation.
2. The data is reprocessed in ChemStation.
3. The data is automatically uploaded to the repository. The storage location in the repository is defined by the original path definitions of the downloaded data.
4. A new version of the data is added to the repository.

Workflow 4: Import after reprocessing

1. Existing analytical data is opened locally.
2. The data is reprocessed in ChemStation.
3. After reprocessing, the data is automatically uploaded to the repository. The storage location in the repository is defined by the current preferences in ChemStation.
4. The initial version of the data is added to the repository.
Overview of workflows for methods/sequence templates/report templates

<table>
<thead>
<tr>
<th>Workflow 1:</th>
<th>Workflow 2:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save new method</td>
<td>Save changed method</td>
</tr>
</tbody>
</table>

**Figure 2**  Overview of workflow for methods, sequence templates, or report templates
Workflow 1: Uploading a new method, sequence template or report template

1 A new method, sequence template, or report template is created.
2 The method, sequence template, or report template is uploaded to the repository using the path selected by the user.
3 The version 1 of the method, sequence template, or report template is automatically created in the repository.

Workflow 2: Saving a changed method, sequence template or report template

1 An existing method, sequence template, or report template is loaded from the repository.
2 The method, sequence template, or report template is modified in ChemStation.
3 The changed method, sequence template, or report template is saved to the repository.
4 A new version of the method, sequence template, or report template is automatically created in the repository.
Storage Model

The Content Management system provides a multi-level storage model. The number of levels is not limited, and you can store your data at any folder level.

Figure 3  Folder structure in Content Management

For convenience, you can use tokens for all elements of the Remote Data Path. The system then automatically creates the corresponding path elements. For example, tokens for the operator name or instrument name are available.
1 Introduction
21 CFR Part 11 Compliance

21 CFR Part 11 Compliance

Effective August 20, 1997, the U.S. Food and Drug Administration (FDA) released and published a new rule to enable pharmaceutical companies to approve their results with electronic signatures and to transfer paper-based documentation into electronic records. This rule is known as 21 Code of Federal Regulations Part 11 (referred to as 21 CFR Part 11) and applies to all industry segments regulated by the FDA.

21 CFR Part 11 includes the US Federal guidelines for storing and protecting electronic records and applying electronic signatures. The intent of these guidelines is to ensure that electronic records subject to these guidelines are reliable, authentic, and maintained with high integrity.

Secure Workstation for OpenLab CDS ChemStation Edition provides the necessary controls for managing system access, audit trail functions, versioning of ChemStation data, and electronic signature functions. These systems ensure secure record keeping and data archival.
This chapter describes how to log in to Secure Workstation for OpenLab CDS ChemStation Edition, explains the user interface items and toolbars related to Content Management, and describes the main preference settings.
License Management

License administration is done using the OpenLab Control Panel. Before adding a license file, you must first purchase the license and generate the license file using SubscribeNet. For more information on generating new license files, refer to the Agilent Secure Workstation for OpenLab CDS ChemStation Edition Installation Guide.

License Management

License Management in OpenLab Control Panel provides the following functions:

- You can add license files to the system.
- You can navigate to the license monitor and view the properties of all licenses installed on the system.
- You can remove license files from the system. This may be useful if an invalid license file has been added.
- You can view, copy, or save the MAC Address of the system.
- You can navigate to the Agilent Electronic Software and License Delivery web page to get a license.

For more information on adding license files and viewing the license properties, refer to the OpenLab Control Panel online help.
Properties

The following properties are shown for installed licenses:

- **Feature**: This indicates the type of license used.
- **Version**: If a license is versioned, you can see the version number. For licenses that are not versioned, the version is always shown as 1.0.
- **In Use (Available)**: This indicates the number of licenses that are currently in use and, in brackets, the total number of licenses. With the OpenLab licensing strategy, a license is only in use as long as a software instance is running (see section *Secure Workstation for OpenLab CDS ChemStation Edition Licensing* in the Agilent Secure Workstation for OpenLab CDS ChemStation Edition Installation Guide).
- **Expiration**: If the license is only valid for a certain period of time, the expiration date is displayed.
- In the **Alerts** pane, you are informed if the number of available licenses has gone down to zero for a specific feature, or if you have started a software instance which requires a license that is unavailable.
Login and Lock Options

User Permissions

You start ChemStation from the OpenLab Control Panel. To prevent unauthorized access, Secure Workstation for OpenLab CDS ChemStation Edition requires authentication with a user name and password. The OpenLab Control Panel allows you to configure the authentication provider, create users and roles to manage user privileges.

For more information on roles and user privileges, see “Privileges in OpenLab Control Panel” on page 106.

User Credentials

The Login dialog requires you to enter a set of valid authorization credentials in order to log in to OpenLab Control Panel.

You need to enter the following login details:

- **Login**: the user name defined in the OpenLab Control Panel.
- **Password**: the password provided by your administrator, which can be changed on request.

ChemStation Operator Name

ChemStation stores the operator name in the sample info (when running single samples) or in the sequence parameters (when running a sequence). The ChemStation operator name is your user name. The operator name cannot be overwritten.
Session lock

If you leave the Secure Workstation computer for a period of time, you can lock ChemStation so that no other user can access the program. This is a safety feature to ensure that there is no unauthorized access to ChemStation. To unlock the session, a user must first provide a valid login before continuing to work with ChemStation.

In ChemStation, there are the following options to activate the session lock:

- **Privately (User > Private Session Lock):** Only the user who activated the session lock, or a user with the **Break Session Lock** privilege, can log in.

- **Non-privately (User > Non Private Session Lock):** Any valid user can log in. This is useful, for example, if there is a shift change, and the leaving personnel locks the ChemStation until the personnel of the new shift starts working.

- **Toolbar lock button:** The toolbar lock button can be configured to lock the ChemStation session privately or non-privately.

- **Time-based:** ChemStation will automatically lock after a given period of time when there is no user interaction (**Inactivity Timeout** setting in the Security Policy area of OpenLab Control Panel).

The time-based session lock can be configured to lock the ChemStation session either privately or non-privately (see “ChemStation Administration Tool” on page 84).
User Interface in ChemStation Related to Content Management

NOTE In ChemStation, you find items related to Content Management under the label CM.

Overview of the Interface Elements

Secure Workstation provides some additional menus and interface elements compared to OpenLab CDS ChemStation Edition without central data storage.
Table 2  Overview of interface elements

<table>
<thead>
<tr>
<th>Menu</th>
<th>Element type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Method</td>
<td>Enable Audit Trail</td>
<td>See “Method Audit Trail” on page 69.</td>
</tr>
<tr>
<td></td>
<td>Command</td>
<td></td>
</tr>
<tr>
<td>Sequence &gt;</td>
<td>Sequence Parameters</td>
<td>See “Remote Data Path as Sequence Parameter” on page 38</td>
</tr>
<tr>
<td>Sequence Parameters</td>
<td>Tab</td>
<td></td>
</tr>
<tr>
<td>Report</td>
<td>Report History</td>
<td>See “Report History” on page 72</td>
</tr>
<tr>
<td>View &gt; Preferences</td>
<td>Tabs In the Preferences dialog:</td>
<td>See “Preferences” on page 27 and “Audit Trails and Logbooks” on page 69.</td>
</tr>
<tr>
<td></td>
<td>Transfer Settings</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Audit Trail</td>
<td></td>
</tr>
<tr>
<td>CM</td>
<td>CM Menu</td>
<td>See “The CM Menu” on page 24</td>
</tr>
<tr>
<td>User</td>
<td>User Menu</td>
<td>See “The User menu” on page 26</td>
</tr>
<tr>
<td>Toolbar (depending on the current view)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shortcuts to several commands of the CM and User menus</td>
<td>Path info in the Data Analysis view: shows the remote path of a file that has been stored to the repository.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Path info in the Method and Run Control view: shows the remote path for automatic upload after acquisition.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Path uses forward slashes (for example, Location/test/test/test).</td>
</tr>
<tr>
<td>Several details related to the repository in the System Diagram in Method and Run Control view (classic ChemStation only).</td>
<td>Details view</td>
<td>The following details are available:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Path</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Operator</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Automatic transfer after acquisition</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Automatic transfer after reprocessing</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Automatic transfer after any data modification</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Automatic import after reprocessing</td>
</tr>
</tbody>
</table>
The CM Menu

All commands related to the repository are available in a separate menu. The menu and its commands depend on the view that is currently active. See the following table for details.

**NOTE**

There is no CM menu in the Verification (OQ/PV) or Diagnosis view.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Views</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Methods ...</td>
<td>Update all methods/sequence templates that are stored in the local file system with the current version from the repository. Local changes are overwritten.</td>
<td>Method and Run Control</td>
</tr>
<tr>
<td>Update Sequences Templates ...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update Report Templates ...</td>
<td>Update all report templates that are stored in the local file system with the current version from the repository. Local changes are overwritten.</td>
<td>Report Layout (Intelligent Reporting)</td>
</tr>
<tr>
<td>Cleanup Data</td>
<td>The Cleanup Data command deletes data or result sets from the local file system that exist in the repository as well. You can delete all data or selected data. Make sure you uploaded the latest version to the repository before you confirm this command. See “Cleanup Data on Shutdown” on page 32.</td>
<td>Data Analysis</td>
</tr>
<tr>
<td>Manage Queue</td>
<td>With the Manage Queue command you can continue any interrupted data upload to the repository. See “Manage Queue on Connect” on page 31.</td>
<td>Method and Run Control, Data Analysis</td>
</tr>
<tr>
<td>Preferences</td>
<td>See “Preferences” on page 27 for more details on the Preferences dialog.</td>
<td>Method and Run Control, Data Analysis, Report Layout (Intelligent Reporting)</td>
</tr>
<tr>
<td>Method-related commands:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Load Method ...</td>
<td>See “Workflows for Methods and Templates” on page 53</td>
<td>Method and Run Control, Data Analysis</td>
</tr>
<tr>
<td>Save Method</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 3  The CM Menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Views</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data-related commands:</td>
<td>See “Data-related workflows” on page 43</td>
<td>• Data Analysis</td>
</tr>
<tr>
<td><img src="image" alt="Load Data ..." /></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Save Data" /></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Save Data As ..." /></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Commands related to the sequence template:</td>
<td>See “Workflows for Methods and Templates” on page 53</td>
<td>• Method and Run Control</td>
</tr>
<tr>
<td><img src="image" alt="Load Sequence Template ..." /></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Save Sequence Template" /></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Commands related to report templates:</td>
<td>See “Workflows for Methods and Templates” on page 53</td>
<td>• Report Layout (Intelligent Reporting)</td>
</tr>
<tr>
<td><img src="image" alt="Load Report Template" /></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Save Report Template" /></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Commands related to reports:</td>
<td>• You can load a specific report template from the repository.</td>
<td>• Review (only available with Intelligent Reporting)</td>
</tr>
<tr>
<td><img src="image" alt="Load Report Template" /></td>
<td>• You can save the report generated with this template as a PDF, XLS, DOC, or TXT file to the repository. TXT files do not contain any graphical information.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Save as PDF" /></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Save as XLS" /></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Save as DOC" /></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Save as TXT" /></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Download Files ...</td>
<td>Download library files (<em>.uvl), column databases (</em>.mdb), Easy Sequence templates (<em>.est), and classic report templates (</em>.frp) from the repository.</td>
<td>• Method and Run Control</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Data Analysis</td>
</tr>
<tr>
<td>Upload Files ...</td>
<td>Upload library files (<em>.uvl), column databases (</em>.mdb), Easy Sequence templates (<em>.est), and classic report templates (</em>.frp) to the repository.</td>
<td>• Method and Run Control</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Data Analysis</td>
</tr>
</tbody>
</table>
## 2 Basic Concepts
User Interface in ChemStation Related to Content Management

### The User menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Available in ChemStation views</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change User ...</td>
<td>Log in as a different user (only affects the ChemStation login, not the OpenLab Control Panel login).</td>
<td>• Method and Run Control&lt;br&gt; • Data Analysis&lt;br&gt; • Review&lt;br&gt; • Report Layout</td>
</tr>
<tr>
<td>Lock Session</td>
<td>• privately&lt;br&gt; • non privately&lt;br&gt; See “Session lock” on page 21.</td>
<td>• Method and Run Control&lt;br&gt; • Data Analysis&lt;br&gt; • Review&lt;br&gt; • Report Layout</td>
</tr>
</tbody>
</table>
Preferences

The Preferences dialog contains two tabs that are relevant to the Content Management system: the Transfer Settings tab and the Audit Trail tab.

NOTE
You can change these settings for all ChemStation instances on the client PC in one single step by using the ChemStation Administration Tool (see “ChemStation Administration Tool” on page 84). If settings have been specified for all ChemStation instances on the computer, you cannot change the settings in the Preferences dialog.

On the Transfer Settings tab, you must specify the following preferences in order to automatically store ChemStation data to a repository:

- Path
- Automatic Data Transfer Settings
- Transfer Management Settings

Each of these items can be specified independently for each instrument. Offline and online sessions are automatically synchronized.
On the **Audit Trail** tab, you can enable the Method Audit Trail and Results Audit Trail. For details on audit trails see “Audit Trails and Logbooks” on page 69.

Figure 5  **Audit Trail** tab in the **Preferences** dialog
Remote Data Path

The remote data path needs to be specified in order to save the data to the correct location in the repository.

In the Preferences dialog, the Transfer Settings tab (see Figure 4 on page 27) allows you to define the Path setting. This path reflects the folder path in Content Management, shown with forward slashes.

Server

This setting provides information about the Content Management instance.

ChemStation obtains this information automatically from OpenLab Control Panel. If the fields are empty or do not match the current configuration, you can click Get Server to reset the fields. ChemStation then keeps the information for future sessions.

NOTE

If you manually enter the server name, and the information does not match the configuration used in OpenLab Control Panel, data upload will fail.

Path

To specify the storage location in the repository, you can either browse to an existing storage location in the repository using the button with the three dots [ ... ], or click the arrow [ ▼ ] to select predefined tokens for automatic path creation. With these tokens, the system automatically creates the required items if they do not already exist in the repository. Tokens are available for the instrument name, the user name, the instrument number, or the computer name.

Alternatively, the path can be specified as Sequence Parameter (see “Remote Data Path as Sequence Parameter” on page 38).

Uploaded files can be stored at any level of the folder hierarchy.

NOTE

If no path is specified, a warning message will be shown at ChemStation startup.
2  Basic Concepts
Preferences

Automatic Data Transfer Settings

In the Preferences dialog (View > Preferences), the Transfer Settings tab allows you to specify the automatic settings for the transfer of raw data. The transfer settings, as well as the Remote Data Path, are used to automatically upload data to the repository.

NOTE

If the Content Management database should become unavailable for any reason, the data cannot be automatically uploaded as specified in the transfer settings. The data is then queued in the Queue Management (see “Queue Management” on page 34).

NOTE

If you perform data acquisition from the Diagnosis view or OQ/PV view, the transfer settings are ignored. The analytical raw data is written to the local ChemStation data file system as predefined in the diagnosis or verification methods.

After Acquisition

If you select this check box the data is automatically uploaded to the repository after an acquisition. The raw data files are written to the local ChemStation file system while the sequence is still running. When the complete sequence is finished, the raw data files are packed in an SSIZip file which is then uploaded to the repository.

For more information, please refer to “Workflow 1: Acquisition and automatic upload” on page 43.

After Any Data Modification

If you select this check box, the result set is automatically uploaded to the repository after you changed the data analysis parameters for a sample and generated a report. The data is uploaded even if you do not reprocess the sequence.

For more information, please refer to “Workflow 2: Offline review during acquisition” on page 45.
After Reprocessing

If you select this check box, the result set is automatically uploaded to the repository each time after you reprocessed the sequence.

For more information, please refer to “Workflow 3: Reprocessing data and automatic upload” on page 48.

Import after Reprocessing

If you select this check box, a sequence that is only stored locally is automatically uploaded to the repository after reprocessing. This setting is useful, for example, if you reprocess data from an older version of ChemStation.

For more information, please refer to “Workflow 4: Import after reprocessing” on page 51.

Transfer Management Settings

Manage Queue on Connect

If the Content Management database should become unavailable for any reason, a running data upload might be interrupted. In this case, the remaining data is written to an internal queue.

If you select the check box Manage Queue on Connect, the queue is shown allowing the user with sufficient privileges to resume the data upload.

Alternatively, you can open the Queue Management dialog (see “Queue Management” on page 34) at any time with the CM > Manage Queue command in the Data Analysis view. The Queue Management dialog box allows you to manage the export of residual ChemStation data to the data repository, if the data repository should have become unavailable for any reason. You can process the queue, save selected items to the local ChemStation file system, or delete items from the queue. If you delete an item from the queue, it will not be transferred to central data storage. If the system activity log has been activated, an entry will be made in the system activity log.
Basic Concepts
Preferences

Cleanup Data on Shutdown

If you select this check box, upon shutdown ChemStation checks the local file system for files that will be or have already been stored in the repository. It deletes all local data and sequence files that are stored in the repository or are queued for an upload. Methods and sequence templates remain on the local file system.

CAUTION

Inadequate check box selection
Loss of data

➔ If you select the Cleanup Data on Shutdown check box, you should also select the Automatic Data Transfer Settings After Acquisition, After Reprocessing, and After Any Data Modification. Otherwise, if the users forget to upload the data to the data repository before closing ChemStation, data might be lost.

CAUTION

Unintentional deletion of data
Loss of data

➔ If you select the Cleanup Data on Shutdown check box and shut down the ChemStation, the item in the Queue may be the only remaining copy of the data. If you want to delete data from the queue while using the Cleanup Data on Shutdown setting, consider saving the item locally first.

NOTE

Consider selecting the Cleanup Data on Shutdown check box when the system shall be compliant to 21 CFR Part 11.
Alternatively, you can open the **Data Cleanup** dialog at any time with the **Cleanup Data** command in the **CM** menu. This dialog box lists all data sets that are also kept in the Content Management system apart from the currently loaded data. The following columns are available:

- **Directory**: Location of the local file
- **CM Information**: Path for the file in the repository
- **Last Modified**: Date/Time when the file in the repository was last changed
- **Locally Modified**: Information whether the local copy has been modified
- **Local Version**: File version that was downloaded to the local directory

You can now manually select the data sets to be deleted from the local disk.

Alternatively, via a drop down list you can deselect all data sets, select all data sets, select only single runs, select only result sets, select items older than one day, or items older than a week.

After pressing **OK**, the local copies of the selected data sets are deleted.

Both automatic cleanup on shutdown and manual cleanup are only possible if the following conditions are fulfilled:

- the ChemStation user is logged on to the Content Management system
- no other instance of the ChemStation instrument is open
- the queue in the Queue Management is empty
- the navigation table is empty (no data loaded)

If one of these conditions is not fulfilled, automatic cleanup will not be performed and it is not possible to open the **Data Cleanup** dialog.
Queue Management

The **Queue Management** dialog is opened via **CM > Manage Queue**. If you selected the check box **Manage Queue on Connect**, and there are interrupted transfers, the dialog is also opened when you start ChemStation.

With this dialog, you can manage the data transfers from ChemStation to the data repository that were interrupted or could not be started. Each failed transfer job is listed in a separate line.

![Queue Management dialog](image)

**Figure 6** Queue Management

- **Description**: Information on the version of the data that will be transferred. Two values are possible:
  - **Import**: Generates the first version. No older version of the data exists in the repository at this time. The data has been newly created and will be uploaded as Version 1.
  - **Commit**: There is already at least one version of the data in the data repository. The version number of the uploaded data will be increased by one. Reprocessing a sequence for example will create a commit entry (version n + 1).

- **Error**: Error that disrupted the data transfer. For details on the possible errors, see “Error Messages in the Queue Management” on page 101.

- **Queued at**: Date when the unsuccessful transfer was queued.

- **Last process at**: Date when the transfer was last attempted.

When the connection to the database is lost, the status line of the ChemStation will show a ”lightning bolt” with a number indicating items in the queue waiting to be uploaded to the backend.
The toolbar offers you the following commands to manage the queue:

**Table 4  Queue management toolbar**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Tooltip</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>Process queue</td>
<td>Continue processing the transfer jobs. As long as there is no error, all pending transfer jobs will be processed in the order as they are shown in the list. This function is only active if you select the first line in the list.</td>
</tr>
<tr>
<td>🖼️</td>
<td>Save selected item locally</td>
<td>Save the data of the corresponding item to the file system.</td>
</tr>
<tr>
<td>✗</td>
<td>Delete selected item</td>
<td>Delete the data of the corresponding item from the queue.</td>
</tr>
<tr>
<td>💼</td>
<td>Properties</td>
<td>Display the Queue Management dialog box, which shows details of the items in the queue in either summary or detailed form.</td>
</tr>
<tr>
<td>🔄</td>
<td>Refresh view</td>
<td>Update the display of the items in the list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong>: If you use the Cleanup Data on Shutdown option in the Transfer Management Settings, this may be the only remaining copy of the data. Consider saving the item locally first.</td>
</tr>
</tbody>
</table>
2 Basic Concepts
Preferences

Queue Management Details Dialog Box

The Queue Management Details dialog box is displayed when you click the tool in the toolbar of the Queue Management dialog box. It shows the command-specific details of the commands in the Queue Management dialog box. The Queue Management Details tabs offer two views of the command details:

- Summary tab
- Details tab

In either tab, the tools in the toolbar allow you to navigate through the command details:

Displays the details of the first command in the list.
Displays the details of previous command in the list.
Displays the details of next command in the list.
Displays the details of last command in the list.

When items are selected from the queue or saved to the local file system, an audit trail entry will be added to the Activity Log in the OpenLab Control Panel.

NOTE When items are deleted from the queue or information on a failed transfer is saved to the local disk, the items have not yet been uploaded to the repository.
Summary tab

The Summary tab gives the following summary information about the selected item:

- **Command Description**
  - The description of the item.
- **Created**
  - The date and time when the item was added to the queue.
- **Changed**
  - The date and time when the item was last processed.
- **Last Error**
  - A description of the error that caused the item to be added to the queue.

Details tab

The Details tab gives detailed information about the selected item. You cannot edit the information in this list. The toolbar provides the following tools:

- ![Sort by Category](image)
  - Sorts the properties by category.
- ![Sort Alphanumerically](image)
  - Sorts the properties alphanumerically.
Remote Data Path as Sequence Parameter

Instead of specifying the remote data path in the Preferences for all acquisition sequences to be run (see “Remote Data Path” on page 29), the remote data path can also be set directly in the sequence template. This allows you to set up different remote paths for each sequence without having to modify the Preferences. The Path for a sequence template is set up in the Sequence Parameters tab.

![Sequence Parameters dialog](image)

Figure 7  Sequence Parameters tab of the Sequence Parameters dialog
**Use Preferences:** When this check box is selected, the remote data path as specified in the Preferences will be used. Any path specified in the Sequence Parameters will be ignored for this sequence. When this check box is cleared, the remote data path will be used as specified when the sequence template is used for data acquisition.

**Path:** To specify the remote data path, you can select a folder path available in the Content Management repository. Click the button with the three dots [...] to select the required path. Alternatively, you can click the arrow [ ] to select one of the predefined tokens for automatic path creation. With these tokens, the system automatically creates the items if they do not already exist in the repository.
Basic Concepts
Compressed ChemStation File Formats

Compressed ChemStation File Formats

When ChemStation data is uploaded to the repository, the data is automatically packaged into an SSIZIP file. Depending on the type of data, different packaging formats are used.

<table>
<thead>
<tr>
<th>ChemStation data</th>
<th>Packaging format</th>
<th>Icon in ChemStation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Runs (containing *.d file, *.rdl files, and DA.M)</td>
<td>*.D.SSIZIP</td>
<td></td>
</tr>
<tr>
<td>Result set</td>
<td>*.SC.SSIZIP</td>
<td></td>
</tr>
</tbody>
</table>
| Result set contains recursively the whole sequence data stored in the sequence subdirectory:  
  * all *.d files along with DA.M  
  * all methods *.m used during acquisition  
  * batch file *.b  
  * sequence logbook file *.log  
  * all *.rdl files used for sequence summary reports and single injection reports |                 |                     |
| Methods                                  | *.M.SSIZIP       |                     |
| Sequence templates                       | *.S              |                     |

The packaging of ChemStation data is part of Secure Workstation and cannot be changed manually.

The packaging is automatically carried out when the data is uploaded to the repository. When the SSIZIP files are downloaded from the repository to ChemStation, they are automatically unpacked into the corresponding directory in the ChemStation Explorer.
This chapter describes the basic workflows for Secure Workstation for OpenLab CDS ChemStation Edition. There are four data-related workflows and two workflows for methods, sequence templates, or report templates.
Transferring Data to or from the Repository

You can open and save different ChemStation items into their ChemStation contexts:

- Methods
- Sequence templates and Easy Sequence templates
- Report templates for Classic or Intelligent Reporting
- Single run data
- Sequence data
- Library files
- Column databases

Methods, single run data and sequence data are stored in the repository as SSIZIP file (see “Compressed ChemStation File Formats” on page 40).

When the data is uploaded to the Content Management repository, local copies of the files still remain in the ChemStation file system. If a file is loaded from the repository back into ChemStation, changes made to this file will automatically be saved into its original location in the repository as a new revision.

While Master Methods, Sequence Templates, and Report Templates can only be saved manually to the repository, Single runs and sequence data will automatically be uploaded to the repository. See “Data-related workflows” on page 43 for details on the different automatic upload options.

For downloading data from the repository, several load commands are available in the CM menu. Depending on the current view, you can load different files.

- In the Data Analysis view, you can load single run data or sequence data.
- In the Method and Run Control view, you can load methods and sequence templates.
- If you use Intelligent Reporting, you can also download report templates from the central data storage in the Report Layout view.

The following workflows are examples that represent typical tasks done with ChemStation.
Data-related workflows

**Workflow 1: Acquisition and automatic upload**

The workflow *Acquisition and automatic upload* illustrates how raw data is uploaded to the repository directly after the acquisition is finished. The raw data is initially stored locally. After completing the acquisition, the data is automatically uploaded to the repository.

![Workflow Diagram](image)

**Figure 8** Acquisition and automatic upload
To save data to the repository automatically after completion of a single run or sequence:

1. Log in to the OpenLab Control Panel and launch an online ChemStation.
2. Load a sequence template.
   Your OpenLab user name is automatically inserted as operator name into the sequence template.
3. Click View > Preferences.
4. On the Transfer Settings tab, configure the following settings:
   - **Path**: Select the location in the repository that you want to use for the sequence data upload.
   - Select the After Acquisition check box.
5. Configure the sequence parameters and the sequence table.
6. Start the acquisition.

While the acquisition is running, the raw data, method definition, and a copy of the sequence template are stored in the ChemStation local file system.

After the sequence is finished, all data is automatically uploaded as an .SC.SSIZIP file to the repository to the previously defined remote path. The local copy of the data remains in the ChemStation local file system. The file name of the result set is determined by the settings in the sequence template (for more details on the sequence template settings, refer to the manual *Agilent OpenLab CDS ChemStation Edition Concepts and Workflows*). After uploading the result set the sequence icon in the ChemStation Navigation Pane changes to . After finishing the upload, the icon changes to . The remote path of the result set is shown in the ChemStation toolbar.

**NOTE**

The color of the Sequence Data icon in the Navigation Pane allows you to track the modification status of the data (the asterisk indicates a pending upload):

- : The result set is queued for an upload, or has been uploaded to the repository and has not been modified locally
- : The result set is queued for an upload, or has been uploaded to the repository and has been modified locally
Workflow 2: Offline review during acquisition

The workflow *Offline revision during acquisition* illustrates how raw data is reviewed while the acquisition is still running. Directly after the acquisition is finished, the original raw data is automatically uploaded to the repository. After the review, the changed data is again uploaded to the repository. When the data is uploaded the second time, a new version is created.

![Diagram of Workflow 2: Offline review during acquisition](image)

*Figure 9*  Offline review during acquisition
To save data to the repository automatically after modification:

1. Log in to the OpenLab Control Panel and launch an online ChemStation.
2. Load a sequence template.
   - Your OpenLab user name is automatically inserted as operator name into the sequence template.
3. Click **View > Preferences**.
4. On the **Transfer Settings** tab, configure the following settings:
   - **Path**: Select the storage location that you want to use for the sequence data upload.
   - Select the **After Acquisition** check box.
   - Select the **After Any Data Modification** check box.
5. Start the acquisition.
   - While the acquisition is running, the raw data, method definition, and a copy of the sequence template are stored in the ChemStation local file system.
6. Open an offline ChemStation and change some data analysis parameters for one of the already finished samples. Save your changes locally.
7. After finishing the acquisition and the work in the offline instance, the following versioning will be done, depending on which occurred first:
   - If the acquisition finished before you have completed your offline changes:
     - The original raw data is automatically uploaded as an `.SC.SSIZIP` file, *Version 1*, to the repository using the previously defined remote data path. The path of the new sequence is shown in the toolbar in the online ChemStation.
     - The file name of the result set is determined by the settings in the sequence template (for more details on the sequence template settings refer to the manual *Agilent OpenLab CDS ChemStation Edition Concepts and Workflows*).
     - The sequence icon in the ChemStation Navigation Pane changes from 📁 to 📁. After finishing the upload, the icon changes to 📁.
Working with Secure Workstation

Data-related workflows

- An Upload dialog opens in the online ChemStation. Click **OK** to confirm that you finished all work in the offline instance. As soon as you confirm this dialog, the changed data is uploaded as *Version 2* to the repository.

  A local copy of the changed data remains in the ChemStation local file system.

  **b** If you saved your offline changes before the acquisition has finished:

  - Upon confirming that you finished your work in the offline instance, the changed data is uploaded as *Version 1* to the repository.

  - The original raw data is automatically uploaded as an *.SC.SSIZIP* file, *Version 2*, to the repository.

**NOTE**

For both versions (the one after acquisition and the one from the parallel offline review) the ChemStation operator is the user who has run the acquisition, even if another user has performed the review in the Offline ChemStation.
Workflow 3: Reprocessing data and automatic upload

The workflow *Reprocessing data and automatic upload* illustrates how data is reprocessed and then automatically uploaded. This workflow applies to data that has been previously stored in the repository. A new version of the data is created in the repository for the reprocessed or changed data.

![Diagram of Workflow 3: Reprocessing data and automatic upload]

**Figure 10** Reprocessing data and automatic upload
To save data to the repository automatically after reprocessing:

1. Log in to OpenLab Control Panel and launch an online or offline ChemStation.

2. Select **CM > Load Data** to download a sequence from the repository.

A dialog opens where you can select the required data. Navigate to the folder that contains your data and select one of the following packaged files:

- Single run data: *.*.D.SSIZIP files
- Sequence data: *.*.SC.SSIZIP files

If the item is checked out, it is marked with a blue or red icon (see marker 1):

- (blue icon): the item has been checked out by you (current user)
- (red icon): the item has been checked out by another user

You can load any checked out item. However, if an item has been checked out by another user, the other user must check in the item before you can save it back to the repository.

To check out or check in an item, you can use the respective icons available in the dialog (see Figure 11 on page 49, marker 2). You can only check out the latest version of an item.
In order to see more details regarding the type and version of the available items, select the **Detail** view (see Figure 11 on page 49, marker 3). To open an older version of an item, select the **Open Revisions** command from the **Open** menu (see Figure 12 on page 50). This opens the **File Versions** dialog, where all available versions of the item are listed (see Figure 13 on page 50).

![Figure 12 Open Revisions command](image)

3 Select **Open** in either dialog to download the item to ChemStation. OR

Select **Open As Checked Out** in order to modify an item. With this option you make sure that you are working on the latest version.

The remote data path is shown in the ChemStation toolbar.

4 In the **Data Analysis** view, click **View > Preferences**.

5 On the **Transfer Settings** tab, configure the following settings:
   - Select the **After Reprocessing** check box.
   - Select the **After Any Data Modification** check box.

6 Modify or reprocess the sequence data.

After the reprocessing is finished, the sequence data is uploaded with its original name to its original remote data path. The version number is increased by one.

The local copy of the reprocessed data remains in the ChemStation local file system.
Workflow 4: Import after reprocessing

The workflow *Import after reprocessing* illustrates how locally saved data is reprocessed and then automatically imported into the repository.

![Diagram of Workflow 4: Import after reprocessing]

**Figure 14** Import after reprocessing
3 Working with Secure Workstation

Data-related workflows

To save data to the repository automatically after reprocessing:

1. Log in to OpenLab Control Panel and launch an offline ChemStation.
2. From the local file system, open a sequence that has never been saved to the repository before.
3. In the Data Analysis view, click View > Preferences.
4. On the Transfer Settings tab, configure the following settings:
   - Path: Select the storage location that you want to use for the sequence data upload.
   - Select the Import after Reprocessing check box.
5. Reprocess the sequence data.

**NOTE**
The data will not be uploaded if you only modify it. You need to reprocess the sequence data.

The sequence data is uploaded as a new .SC.SSIZIP file, version 1, to the previously defined remote data path in the repository. The file name of the result set is determined by the settings in the sequence template (for more details about the sequence template settings refer to the manual Agilent OpenLab CDS ChemStation Edition Concepts and Workflows).

The sequence icon in the ChemStation Navigation Pane changes from to .

After finishing the upload, the icon changes to .

The local copy of the reprocessed data remains in the ChemStation local file system.
Workflows for Methods and Templates

The following workflows are applicable to methods and sequence templates. If you enabled Intelligent Reporting in Instrument Configuration in the OpenLab Control Panel, these workflows also apply to report templates. The diagrams show the workflows using methods as an example.
Workflow 1: Save new method

The workflow *Save new method* illustrates how newly created or locally stored methods or sequence template can be manually uploaded to the repository.

**Figure 15**  Save new method, sequence template, or report template
To upload a new method, sequence template, or report template:

1. Log in to OpenLab Control Panel and launch an offline ChemStation.
2. In ChemStation, load the method/sequence template/report template or create a new one.
3. Select the appropriate Save command from the CM menu.
   - In the Method and Run Control view:
     - Save Method
     - Save Sequence Template
   - In the Report Layout view (only with Intelligent Reporting):
     - Save Report Template
4. In the Save dialog, navigate to the remote data path of your choice to upload the method/sequence template/report template.
5. If necessary, save the item using a different name. The original name is used by default, but you can modify the name.
6. Click Save.

   The Add File dialog opens.

7. Enter a reason for the upload and click OK. The reason is then shown in the Content Management Audit Trail (see “Content Management Activity Log” on page 73).

   The progress of the upload is displayed in a window until the item is uploaded.

   After finishing the upload, the SSIZIP file is available in the repository as version 1. The file is saved to the remote data path defined in the Preferences (see “Remote Data Path” on page 29).

   The method icon in the ChemStation Navigation Pane changes from 📁 to 📁.

   The icon for a sequence template changes from 📁 to 📁.

   The icon for report templates changes from 📁 to 📁.
Workflow 2: Save changed method

The workflow *Save changed method* illustrates how methods, sequence templates, or report templates that are already stored in the repository are edited and saved under the same name as a new version.

![Diagram of Workflow 2: Save changed method](image)

**Figure 16**  Save changed method
1 Log in to OpenLab Control Panel and launch an online or offline ChemStation.

2 Load a method, sequence template, or report template.
   - Open a method/sequence template/report template from the ChemStation local file system. Choose an item that has been uploaded to the repository before. Methods are indicated by 😊, sequence templates by 🎉, and report templates by 🎉 in the ChemStation Navigation Pane.
   - or –
   - Select the **Load Method**, **Load Sequence Template**, or **Load Report Template** commands in the **CM** menu to download an item from the repository.

If you use one of the Load commands, a dialog will open where you can select the required data. Navigate to the folder to load the method (*.M.SSIZIP), sequence template (*.S or *.S.SSIZIP), or report template (*.RDL) of your choice.

![Figure 17 Date Store Open File dialog](image)

If the item is checked out, it is marked with a blue or red icon (see Figure 17 on page 57, marker 1):

- 😊 (blue icon): the item has been checked out by you (current user)
- ⬆️ (red icon): the item has been checked out by another user
You can load any checked out item. However, if an item has been checked out by another user, the other user must check in the item before you can save it back to the repository.

To check out or check in an item, you can use the respective icons available in the Open dialog (see Figure 17 on page 57, marker 2). Using these icons, you can only check out the latest version of an item.

In order to see more details regarding the type and version of the available items, select the **Detail** view (see Figure 17 on page 57, marker 3). To open an older version of an item, select the **Open Revisions** command from the **Open** menu (see Figure 18 on page 58, marker 1). This opens the **File Versions** dialog, where all available versions of the item are listed (see Figure 19 on page 58).

![Figure 18: Open Revisions command](image)

![Figure 19: File Versions dialog](image)

3 Select **Open** in either dialog to download the item to ChemStation. To prevent other users from modifying the item, select the **Open As Checked Out** command. The item is then marked as checked out in the central data storage system (see Figure 17 on page 57, marker 2).

**NOTE**

ChemStation files (data, methods, sequence templates, and report templates) are not automatically checked out of the central data storage system! In order to modify those items in ChemStation, check them out manually. Otherwise, there is no guarantee that you are working on the latest version.
If the file already exists in the ChemStation local file system in the specified location, you must choose a different download location. The remote path of methods and templates is shown in the ChemStation toolbar.

4 Make the required changes to the loaded item.

A modified method is indicated by 📕 in the navigation pane.

A modified sequence template is indicated by 📕.

A modified report template is indicated by 📕.

5 Select the appropriate Save command in the CM menu to save the changed item:

- Save Method
- Save Sequence Template
- Save Report Template

NOTE
If you have not checked out the item before loading it from the Content Management repository, and another user has checked out the item in the meantime, you cannot proceed with the upload back to the repository. A warning message is displayed, and it is not possible to save the item until the other user has released the checked out item.

6 When the Add File dialog opens, enter a reason for the upload and click OK. The reason is then shown in the Content Management Audit Trail (see “Content Management Activity Log” on page 73).

The progress of the upload is displayed in a window until the item is uploaded to the repository.

The .M_SSIZIP/.S/.RDL file is uploaded with its original name to its original remote data path (the path is shown as a tooltip of the method/sequence template/report template in ChemStation). The version number is automatically increased by one.
3 Working with Secure Workstation
Workflows for Methods and Templates

Updating the Local Master Method, Sequence Template, or Report Template

A copy of files (Master Method, Sequence Template, or Report Template) that are uploaded to the central repository is kept locally and may not be the latest version. The update command will allow you to download the latest version and update the local copy.

1 Make sure the master method, sequence template, or report template to be updated is currently not loaded. A currently loaded item is not available for update.

2 Select the appropriate Update command from the CM menu:
   - Update Methods ...
   - Update Sequence Templates ...
   - Update Report Templates ...

![Figure 20 Update Methods dialog box](image)
A dialog box is displayed where you can select the items to be updated. The dialog box lists all items that have previously been uploaded to the repository. The following columns are available:

- **Name**: Path and Name of the local copy of the method, sequence template, or report template.
- **CM Information**: Path of the file in the repository.
- **Locally Modified**: A check box indicating whether the local copy was modified.
- **Local Version**: Version number of the local copy of the method, sequence template, or report template.
- **CM Version**: Version number of the file in the repository.

You can now manually select the items that are to be updated. Alternatively you can use the drop down list to deselect all items, select those items with a higher version number in the repository, or select all items that have been modified locally.

After clicking **OK**, the selected local items are updated with the file version from the Content Management system.
3 Working with Secure Workstation
Workflows for Methods and Templates
## 4 Administration Regarding 21 CFR Part 11 Compliance

### Introduction to 21 CFR Part 11 65

- 21 CFR Part 11 Requirements 66

#### General Aspects of Data Security in Computerized Networks - Open Versus Closed Systems 66

### Overview of Configuration Steps Required for Part 11 68

- Audit Trails and Logbooks 69
  - Method Audit Trail 69
  - Results Audit Trail 71
  - Sequence Audit Trail 71
  - Report History 72
  - Content Management Activity Log 73
  - System Activity Log in OpenLab Control Panel 74

- Security Policy 75
  - To Configure the Security Policy 75
  - User-Specific Settings 77

- Users/Groups/Roles Configuration 79
  - Settings in OpenLab Control Panel 79

- ChemStation Administration Tool 84
  - Enabling users to start the ChemStation Administration Tool 85
  - Session Lock Settings 87
  - Data Handling and Audit Trail Configuration 88
  - Configuration Profiles 88
  - Folder Protection with Secure File I/O 89
This chapter explains the purpose of 21 CFR Part 11 and how Secure Workstation for OpenLab CDS ChemStation Edition addresses the requirements of 21 CFR Part 11.
Introduction to 21 CFR Part 11

Effective August 20, 1997, the U.S. Food and Drug Administration (FDA) released and published a new rule to enable pharmaceutical companies to approve their results with electronic signatures and to transfer paper-trail documentation into electronic records. This rule is known as 21 Code of Federal Regulations Part 11 (referred to as 21 CFR Part 11) and applies to all industry segments regulated by the FDA.

The impact of this rule on current work practices and data handling in the pharmaceutical industry has been much higher than expected. “The industry wanted to have a rule on electronic signatures, but what they got was a rule on electronic records.” (Martin Browning, former FDA inspector, during a validation seminar in Washington D.C.)

21 CFR Part 11 places high emphasis on the implementation of all measures to protect and secure electronic records. Notwithstanding the uncertainties and the changes that 21 CFR Part 11 requires in the behavior of both the pharmaceutical industry and the vendors of chemical analysis equipment, it is well worth implementing in today’s laboratories because it can help the industry with one of the most important issues in pharmaceutical research-bringing new drugs on the market faster.

The major benefits of this shift towards electronic data management are in the potential productivity increase for the industry. The industry can decrease its data output on paper, speed up the data review and approval process, and benefit from new automation technology based on computerized system control, for example, in manufacturing or dissolution drug release testing.

In addition to this rule on electronic records, other general requirements for computerized systems are brought to the auditor’s attention. These rules cover the basic requirements of validation which are limiting data access and ensuring data integrity and data traceability.

It is, of course, the industry that must ensure that its work practices support the FDA rules, but most of the requirements also affect the chemical analysis systems and suppliers of these systems.
**21 CFR Part 11 Requirements**

To fulfill the FDA rules and guidelines for compliant electronic records and computerized systems, it is important to understand the basic aspects of secure data handling.

- **Data security:** physical protection of data by limiting access to the system and preventing unauthorized access.

- **Data integrity:** protecting raw data and metadata and preventing these from unauthorized modification, and linking raw data and results to reproduce the original results at any time, for example, in an audit situation, and document each new result copy.

- **Audit traceability:** documenting who did what to the results and when, and tracing the user adding new reanalyzed versions to the original raw data.

**General Aspects of Data Security in Computerized Networks - Open Versus Closed Systems**

Before discussing details of data security in a chromatographic system, some general aspects of data security in a computerized network need to be considered.

It is generally known that data transfer over a public network can be accessed by unauthorized external persons, "hackers", who gain access either for personal amusement or intentional fraud.

If an electronic identification comprising user ID and a password is used to approve confidential or important data, users must be sure that their signatures are unbreakably linked to the data and that nobody can copy this signature or get access to the passwords. In a public system, this would require additional encryption technology, for example, a private/public key combination of data encryption. In contrast, if a computerized system is protected from unauthorized access, users can be sure that their signatures are private and are not accessible to unauthorized individuals.

The FDA also distinguishes between these two scenarios and defines them as *open* and *closed* systems. A *public* network system can therefore only be viewed as an open system and a protected network as a closed system, if it fulfills additional requirements.
In FDA terms, "closed system means an environment in which access is controlled by persons who are responsible for the content of electronic records on the system" (11.3.5). The evidence of a system being a closed system is not a one-time check but an ongoing process of executing and documenting the system controls that make sure that the system is closed. In contrast, in an open system, "those persons being responsible for the content of electronic records do not control the system access."

As a result, open systems require additional encryption technology for all data transfer over the network.

Agilent OpenLab CDS is designed for and supported in closed systems.
Overview of Configuration Steps Required for Part 11

If you want to configure Secure Workstation for OpenLab CDS ChemStation Edition to be compliant with 21 CFR Part 11, you need to go through the following checklist:

- Directory structure in the Content Management repository prepared according to your needs
  See “Storage Model” on page 15.
- Roles/Users/Groups configured in OpenLab Control Panel
  See “Users/Groups/Roles Configuration” on page 79.
- Configuration of the Content Management system with active audit trail and mandatory reason
  See “Content Management Activity Log” on page 73.
  See “To Configure the Security Policy” on page 75.
- Password policy realized in OpenLab Control Panel
  See “User-Specific Settings” on page 77.
- E-Signatures prepared (privileges)
  See “Using electronic signatures” on page 94.
- Automatic Data Transfer Settings and Transfer Management Settings activated
  See “Automatic Data Transfer Settings” on page 30.
- Audit trail active for methods and results
  See “Method Audit Trail” on page 69 and “Results Audit Trail” on page 71.
- Folders protected from external modification
  See “Folder Protection with Secure File I/O” on page 89
- Emergency Plan available, based on options of the Administration Tool
  See “ChemStation Administration Tool” on page 84.
Audit Trails and Logbooks

In order to comply to 21 CRF Part 11, Secure Workstation for OpenLab CDS ChemStation Edition offers various audit trails and logbooks to document all activities associated with methods, results, reports, or any files stored in the repository. These audit trails and logbooks track all changes that are made to any file, including data acquisition, re-analysis, and long-term archiving.

Audit trails are stored in separate files, which are stored together with the sample or method data. The audit trail files are archived together with the other data in the respective SSIZIP files. Logbooks are available only in the Content Management system.

Method Audit Trail

Each method has a Method Audit Trail. By default, this Method Audit Trail contains only the comments that you must provide each time when you save a method. As there is no control on the provided text, there is no guarantee that the method changes are reproducible.

With regards to 21 CFR Part 11, Secure Workstation for OpenLab CDS ChemStation Edition makes it possible to generate a more detailed Method Audit Trail. If the function is activated, the Method Audit Trail contains not only the user comments, but also each individual changed parameter with its old and new value. All changeable data analysis parameters are tracked. This means that you can reproduce exactly which value has been changed to what, when, and by whom.

Depending on the instrument driver, the Method Audit Trail may also contain an entry for each changed instrument setting.
To enable the Method Audit Trail only for the currently open method

You can also activate the Method Audit Trail only for one method. This might be useful, for example, when you finished the development of new method and want to track all further changes.

1. Select **Method > Enable Audit Trail**.
2. In the **Audit Trail Status** dialog, select **Enable Method Audit Trail for this method**.

To enable the Method Audit Trail for all methods

This is required if you want to comply to 21 CFR Part 11.

1. Select **View > Preferences**.
2. On the **Audit Trail** tab, select **Enable Audit Trail for all methods**, and click **OK**.
   
   Once enabled, the Method Audit Trail cannot be disabled.

NOTE

You can also use the ChemStation Administration Tool to enable the Method Audit Trail for all methods and all instruments (see “ChemStation Administration Tool” on page 84).

To view the Method Audit Trail for the currently open method in ChemStation

1. Select **Method > Method Audit Trail**.

NOTE

Once a method is enabled for the detailed audit trail, you cannot disable it again. You can only save the method under a different method name. The new Audit Trail of the new method will then contain a comment about the method being based on the existing method.
Results Audit Trail

The Results Audit Trail contains information on manual integration events that are not saved to a method. Manual integration events that are saved to a method are listed in the corresponding Method Audit Trail.

If activated, this Results Audit Trail is added to the existing Data File Logbook (file name RUN.LOG). By default, the Data File Logbook only contains the acquisition parameters and reprocessing information for each sample. The Results Audit Trail additionally tracks the changes of all data analysis parameters for a sample.

To enable the Results Audit Trail

If you enable the Results Audit Trail, the relevant changes are tracked for all samples, independent of the sequence they belong to and independent of the user who carries out the change.

1. Select View > Preferences.
2. On the Audit Trail tab, select Enable Results Audit Trail.

To view the Results Audit Trail for the loaded sample in ChemStation

1. In the Data Analysis view, select View > Current Data File Logbook.

Sequence Audit Trail

The Sequence Audit Trail is automatically activated when the Results Audit Trail is enabled and will track changes made to the running sequence. The audit trail is saved along with the sequence, and tracks all changes to:

- the Sequence Table:
  - changes to any table cells
  - insertion and deletion of sequence lines
- the values in the Sequence Parameters dialog box
- values in sequence-related custom fields
For each change, the application logs:

- the date and time of creation of the audit trail entry
- the user who was logged on when the audit trail entry was generated
- a system-generated description of the change that resulted in the audit trail entry
- a user-generated comment

The latest Sequence Audit Trail entry is added to the top of the list. The list can be displayed and printed.

**To view the Sequence Audit Trail for the currently loaded sequence**

1. In either the Method and Run Control view or the Data Analysis view, select Sequence > Sequence Audit Trail.

**Report History**

If you create a ChemStation report, you can display the report on the screen, send it to a printer, or save the report as a specific file (*report.pdf*). These report outputs may easily be lost or overwritten, especially when you create several reports one after another.

ChemStation automatically tracks all reports that have been generated. If you have the results audit trail enabled you may see the Report History, that allows to reproduce an old or overwritten report. Select Report > Report History to see all reports created for the current data file. You can also export or print this history.
Content Management Activity Log

The Content Management Activity Log is a record showing who accessed the system and what operations a user performed during a given period of time.

It contains information related to files, system administration, and folder administration. For example, you can see when a file was added and who added it.

For each operation, the Content Management system asks the user for a reason. This reason is also shown in the Activity Log. For automatic uploads there are default reasons given by the system.

The Content Management Activity Log is enabled by default.

To view the Activity Log for a specific file in ChemStation

You can view the Activity Log for a specific file directly in ChemStation.

1. In the ChemStation Explorer, right-click the respective file.
2. Select CM Properties... from the context menu.
   This command is only available if the file has been uploaded to the data repository.
3. In the File Properties dialog, select the Activity Log tab.
   This tab contains all Activity Log entries associated with the file.

To view the Activity Log for a specific file in the Content Browser

1. In the Content Browser, navigate to the respective file. Move the mouse over the file name, and click the Activity Log icon of this file.

To view the entire Activity Log in the Content Browser

In the Content Management system, there is only one single activity log for the entire system. System activities are stored at the same place as file activities. If you do not open it for a specific file, it shows all activities.

1. In the Content Browser, click Activity Log in the top toolbar.
   You can filter the list by date range and user name.

NOTE

The user name is case sensitive and needs to be an exact match.
System Activity Log in OpenLab Control Panel

The System Activity Log allows you to centrally access all system activities. It contains information on the various events associated with Shared Services or with specific instruments. You can filter the list in order to view events of a specific type, in a specific time range, created by a specific user, or containing a specific description only.

The following types of events are recorded:
- System (e.g. Control Panel specific events)
- Instrument Management (e.g. Adding instruments)
- Instrument (e.g. instrument specific error messages)
- Instrument Controller (e.g. adding a new Networked Workstation or AIC)
- User (e.g. adding a new user or changing user privileges)
- Group (e.g. adding a new user group or changing group privileges)
- Security (e.g. successful and unsuccessful login events)
- License (e.g adding a new license)

The messages can come from other components, such as the user management, or from an instrument module. Instrument messages include error messages, system messages or event messages. ChemStation records these events in its own environment but also sends the events to the System Activity Log. The System Activity Log records these events irrespective of whether you have been alerted to them or not. To get more information on an event, expand the line of interest in the activity logbook viewer.

**NOTE**

By default, activity logging is disabled. To enable it in OpenLab Control Panel, you must have the Edit activity log properties privilege. Once enabled, activity logging cannot be disabled again.

To Enable the System Activity Log

1. In the OpenLab Control Panel, select the Administration > System Configuration page.
2. In the ribbon, click Activity Log Settings.
3. In the Activity Log Settings dialog, select the Write activity log check box, and confirm your settings.
Security Policy

21 CFR Part 11 requires that the company or laboratory have a security policy in place to ensure that only authorized users access the data.

To Configure the Security Policy

1. In the OpenLab Control Panel, select Administration > Security Policy from the navigation pane.

Table 5  Security Policy settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>21 CFR Part 11 Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum password length</td>
<td>If users change their passwords, they must choose a password with at least the given number of characters. The default setting is 5.</td>
<td>You should require a minimum password length of at least 5 characters.</td>
</tr>
<tr>
<td>Password expiration period (days)</td>
<td>The default value is 30 days. When the user tries to log in after this period of time, the system will ask him to change the password. The expiration period starts with the last password change or with the creation of a user with a new default password.</td>
<td>You should use an expiration period of 180 days or less.</td>
</tr>
</tbody>
</table>
### Security Policy settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>21 CFR Part 11 Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum unsuccessful login attempts before locking account</td>
<td>If a user tries to log in with invalid user credentials a number of times, the user is locked out of the system for a certain period of time (<strong>Account lock time</strong>, see below). Login is impossible, even with valid user credentials. You can define the number of allowed login attempts. The default setting is 3.</td>
<td>You should limit the number of allowed login attempts to three.</td>
</tr>
<tr>
<td>Account lock time (minutes)</td>
<td>Once a user has exceeded the maximum number of allowed unsuccessful login attempts, this is the amount of time that must pass before he can try again. The default setting is 5 min.</td>
<td></td>
</tr>
<tr>
<td>Inactivity time before locking the application</td>
<td>If the OpenLab Control Panel is inactive for this amount of time, the user interface will be locked. This setting is also used to set the time-based session lock in ChemStation. The default setting is 10 min. Set the value to zero to never lock.</td>
<td></td>
</tr>
</tbody>
</table>
User-Specific Settings

21 CFR Part 11 does not define any specific rules for the password settings. However, your company must have defined a password policy.

To configure password settings in OpenLab Control Panel

1 In the OpenLab Control Panel, select Administration > Users from the navigation pane.
2 Select a user, and click Edit in the ribbon.

With the authentication provider set to Internal, you can configure the following settings on the General tab:

<table>
<thead>
<tr>
<th>Table 6  User Credentials</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Value</strong></td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td><strong>NOTE</strong></td>
</tr>
<tr>
<td>Description</td>
</tr>
<tr>
<td>Password</td>
</tr>
<tr>
<td>Email address</td>
</tr>
<tr>
<td>Full name</td>
</tr>
<tr>
<td>Contact Information</td>
</tr>
<tr>
<td>Password never expires</td>
</tr>
</tbody>
</table>
### Security Policy

#### Account is disabled
- Select the check box to disable an account. Users with disabled accounts cannot log in any more. Accounts may be automatically disabled after too many failed login attempts. If an account is disabled, a corresponding message is displayed instead of the check box. After a given time (see Account lock time in the Security Policy settings), the account is automatically enabled again.

#### User cannot change password
- Flag that indicates whether the user can change his own password. The flag is false by default (that is, users CAN change their passwords).

#### User must change password at next login
- If set to true, the user has to change his password at the next login. The flag is automatically set to false after the user has changed the password successfully. The flag is true by default for new users.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account is disabled</td>
<td>Select the check box to disable an account. Users with disabled accounts cannot log in any more. Accounts may be automatically disabled after too many failed login attempts. If an account is disabled, a corresponding message is displayed instead of the check box. After a given time (see Account lock time in the Security Policy settings), the account is automatically enabled again.</td>
<td>No</td>
</tr>
<tr>
<td>User cannot change password</td>
<td>Flag that indicates whether the user can change his own password. The flag is false by default (that is, users CAN change their passwords).</td>
<td>No</td>
</tr>
<tr>
<td>User must change password at next login</td>
<td>If set to true, the user has to change his password at the next login. The flag is automatically set to false after the user has changed the password successfully. The flag is true by default for new users.</td>
<td>No</td>
</tr>
<tr>
<td>Group Membership</td>
<td>Assign the user to the relevant groups.</td>
<td></td>
</tr>
<tr>
<td>Role Membership</td>
<td>Assign roles directly to the user.</td>
<td></td>
</tr>
</tbody>
</table>
Users/Groups/Roles Configuration

Users with specific roles and privileges are required in Secure Workstation for OpenLab CDS ChemStation Edition. First, you need to authenticate with a user name and password when you start the application. Then, additional privileges are required for specific functions.

In Secure Workstation for OpenLab CDS ChemStation Edition, user management is part of Shared Services, which you access via the OpenLab Control Panel. You are asked to create an administrator account for OpenLab Shared Services before setting up other users. Each user can be member of specific groups. To each group, you can assign predefined roles that comprise specific privileges.

After the installation the software will be automatically configured to use OpenLab Shared Services internal authentication. If needed, user accounts from a Windows domain can be used, this requires the computer to join the corresponding domain and the authentication provider must be reconfigured.

Settings in OpenLab Control Panel

Users in OpenLab Control Panel

The Administration view in the OpenLab Control Panel allows you to define users, roles, and group membership.

Each user can be member of multiple groups. You must assign a specific role to each group. You can also assign roles to single users; however, for the sake of clarity, it is strongly recommended to assign roles only on the group level.

The roles are equipped with numerous specific privileges which define what the users are allowed to view or do in Secure Workstation for OpenLab CDS ChemStation Edition.
Roles and Privileges in OpenLab Control Panel

Roles are used to assign privileges to a user or a user group globally or for a specific instrument or location. The system contains a list of predefined roles which are installed as part of the system installation (for example, **Instrument Administrator**, **Instrument User**, or **Everything**). Each role has certain privileges assigned.

Privileges are grouped according to the three main role types (Project role, Instrument role, and Administrative role). When you assign privileges to a role, you first select the required role type and then select the privileges related to this role type. Each role can only have privileges of one specific role type; the only exception is the predefined role **Everything**, which has all privileges of all role types. Users or groups may require multiple roles to perform system functions. For example, a user with the role *ChemStation Operator* will always need another role such as *Instrument User* with the privilege to run an instrument.

<table>
<thead>
<tr>
<th>Role Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrative privileges</td>
<td>These privileges are globally assigned to a user or group and cannot be changed on the instrument/location level. They are the typical administration privileges such as <strong>Backup and restore</strong>, <strong>Manage security</strong>, <strong>Manage printers</strong> etc.</td>
</tr>
<tr>
<td>Instrument privileges</td>
<td>These privileges can be assigned globally or on the instrument/location level. Privileges for instruments are, for example, <strong>View instrument or location</strong> and <strong>Run instrument</strong>. Users need the <strong>View instrument or location</strong> privilege on the global level to see the locations and instruments tree in the OpenLab Control Panel.</td>
</tr>
<tr>
<td>Project privileges</td>
<td>Privileges for accessing or modifying different levels of data.</td>
</tr>
<tr>
<td></td>
<td>• These privileges are globally assigned to ChemStation users.</td>
</tr>
<tr>
<td></td>
<td>• Projects can be used to assign privileges to content areas in the Content Management system (see “Using Projects” on page 83).</td>
</tr>
</tbody>
</table>
You can create a tree of different locations in the OpenLab Control Panel, and add instruments to the relevant locations. For each instrument or instrument group, you can assign different Instrument roles (see also “Specific Privileges for Individual Nodes” on page 83). For example, a user can have the role Instrument Administrator for one instrument, and Instrument User for another instrument.

For a detailed list of privileges, see “Privileges in OpenLab Control Panel” on page 106 in the Appendix.

**Privileges Related to Content Management**

The following tables describe the privileges that are relevant for Content Management.

**Table 8** Administrative privileges

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archive content</td>
<td>The role Archivist includes this privilege by default. The user can archive and de-archive the content of the data repository.</td>
</tr>
</tbody>
</table>
### Table 9  Project privileges

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View project or project group</td>
<td>By default, this privilege is included in the <strong>Project Administrator</strong> role and in all <strong>ChemStation</strong> roles. The user can see a project and project details in OpenLab Control Panel, but cannot edit. Also, he can view the content of the data repository.</td>
</tr>
<tr>
<td>Manage project or project group</td>
<td>By default, this privilege is included in the <strong>Project Administrator</strong> role. User can create or edit project properties and can move the project but cannot access settings. See also “Using Projects” on page 83.</td>
</tr>
<tr>
<td>Edit content of project</td>
<td>By default, this privilege is included in the <strong>Project Administrator</strong> role. The user can create new versions of documents in the Content Management system.</td>
</tr>
<tr>
<td>E-Signature Sign Data Files</td>
<td>By default, this privilege is included in the <strong>Project Administrator</strong> role. The user can sign data files, view and edit project properties and create new versions of documents in the Content Management system.</td>
</tr>
<tr>
<td>Access content using web client</td>
<td>By default, this privilege is included in all <strong>Content Management</strong> roles. The user with this privilege is able to open the Content Browser interface.</td>
</tr>
</tbody>
</table>
Using Projects

With Secure Workstation for OpenLab CDS ChemStation Edition, you can enable projects in the OpenLab Control Panel. Projects contain a path to a project folder in the Content Management system. For each project, you can assign specific content privileges to the users.

To Enable Projects

1. In the OpenLab Control Panel, navigate to Administration > System Configuration.
2. In the ribbon, click Enable Projects.
3. In the confirmation dialog box, click OK.

For details on assigning specific privileges to a project, see “Specific Privileges for Individual Nodes” on page 83.

Specific Privileges for Individual Nodes

By default, the roles of users or groups are globally set for all locations, instruments, project groups, or projects. The role settings are inherited from the root node Instruments or Projects respectively. In order to assign a different role to a user or group for one specific node, you can deselect the Inherit privileges from parent check box in the Edit Privileges dialog for the required node. Afterwards, you can assign a different role that will be valid only for the specific node.

You can assign Instrument roles to individual locations or instruments.

If you use projects, you can assign Project roles to individual project groups or projects. For more information, see “Using Projects” on page 83.

Administrative roles are always set globally.
ChemStation Administration Tool

The ChemStation Administration Tool offers a number of functions related to the ChemStation configuration. As one of these functions is to break the session lock, access to the ChemStation Administration Tool is strictly limited:

The ChemStation Administration Tool can only be started by users who are a member of the local user group **CSAdministrators** (see “Enabling users to start the ChemStation Administration Tool” on page 85).

**To start the ChemStation Administration Tool:**

1. From the Start menu in the Task Bar, select **Start > All Programs > Agilent Technologies > ChemStation Administration Tool**.

![ChemStation Administration Tool](image)

**Figure 21** ChemStation Administration Tool
Enabling users to start the ChemStation Administration Tool

During the installation of Secure Workstation for OpenLab CDS ChemStation Edition, the local user group **CSAdministrators** is automatically created. Only members of this group are allowed to run the ChemStation Administration Tool. The user who installs ChemStation is automatically added to the **CSAdministrators** group. Additionally, the Windows group **Administrators** and the user who installs ChemStation are granted Full Control privileges on the Administration Tool program executable (Agilent.ChemStation.ECM.ECMAdmin.exe) itself, thus they are able to run the tool.

To add a Windows user to the CSAdministrators group:

1. Go to **Start > Control Panel > Administrative Tools**.
2. Select **Computer Management**

![Computer Management](image)

**Figure 22** Computer Management window

---

1 View the items by icon to see a list of all items
3 Under **Groups**, right-click the group **CSAdministrator** and select **Add to Group**... from the context menu.

The **Properties** dialog shows the users who are currently members of the group.

4 Use the **Add** button to add the required users.

After confirming with **OK**, the **Properties** dialog also contains the newly added users.
Session Lock Settings

In the ChemStation Administration Tool, you can set the following options for creating and breaking session locks:

- **Break session lock**: If you select this check box, a locked ChemStation can be accessed by any user just by clicking **OK** in the **Login** dialog. Login credentials are ignored then. If a ChemStation is currently locked and the authentication provider is unavailable, selecting this check box is the only way to regain access to the current ChemStation session.

  **NOTE** Be aware that, as a consequence, the user who regained access to ChemStation now has unlimited access to all ChemStation functions.

- **Time based session lock locks private**: If ChemStation has been locked by a session time out, only the current user or a user with the required privileges can unlock this session.

- **Toolbar lock button locks private**: If ChemStation has been locked using the Lock button on the ChemStation toolbar, only the current user or a user with the required privileges can unlock this session.
Data Handling and Audit Trail Configuration

The ChemStation Administration Tool offers to conveniently configure all ChemStation instances on the Secure Workstation at the same time with the same settings. By default, the option **Use these settings for all instances on this computer** is already selected.

**To force the settings for all ChemStation instances**

1. Select the option **Use these settings for all instances on this computer**.
2. Select the required check boxes. The settings are the same as in the Preferences dialog (see “Preferences” on page 27).
3. Click **OK**.

Configuration Profiles

With the specific client services profile **OlssDataStore**, you can activate specific functions and behaviors in ChemStation.

ChemStation communicates with OpenLab Shared Services; ChemStation sends status information to OpenLab Shared Services, and allows transferring data files to and from the Content Management data repository. It uses the settings defined in OpenLab Shared Services (for example, user authentication, roles and privileges, configuration settings, audit trail settings).

This profile is used for Secure Workstation for OpenLab CDS ChemStation Edition.
Folder Protection with Secure File I/O

ChemStation metadata such as validated master methods or sequences templates must be stored in secured locations in your content management system. For usage with your instruments these methods or sequence templates are also stored in various local folders. By default, the content of these folders is not protected against modification or deletion from local file browsers or from file dialogs within ChemStation.

To ensure data integrity, enable the Secure File I/O function for ChemStation. All relevant local paths will then be protected. The relevant paths are set by default, but can also be configured. The content of protected paths can no longer be modified by Windows file operations because access is denied for members of the Windows user group **Interactive**. The protected folders can only be used inside ChemStation. If user authentication is enabled, only users with sufficient privileges can delete the locally stored data for housekeeping purposes. If those methods or sequences have been actively used with your instrument, copies are also stored along with results and their associated audit trails.

Prepare Secure File I/O in Windows

1. Ensure that all relevant ChemStation folders are on an NTFS file system.
2. Do not use ChemStation folders on removable storage devices (for example, external disks or USB media).
3. Create a standard user account (local or domain) with the same or fewer privileges than a normal ChemStation user. Do not grant administration or power user privileges.
   - This account will be used by the ChemStation for internal file operations. As the user is not supposed to log on interactively, do not use the option **Change password at next logon**.

   **NOTE**

   Consider using a password that never expires. If this is not possible due to your security policy, plan a downtime for ChemStation while updating the password.

   As long as the password for this user account is expired, do not use the ChemStation. ChemStation will not work properly until you have updated the password in the ChemStation Administration Tool.

---

1 In Windows, all users who log on interactively are automatically assigned to the **Interactive** group. The membership persists for the time the users remain logged in.
Enable Secure File IO in ChemStation

1. Click **Start > All Programs > Agilent Technologies > ChemStation Administration Tool** to open the ChemStation Administration Tool.

2. In the ChemStation Administration Tool, select the **enable secure file IO** check box.

3. Provide the credentials of the special user account that you have prepared.

4. Click **Apply**.

5. A dialog lists all directories that are going to be protected. Click **OK** to confirm.

   For all paths that are protected, a ProtectionInfo.xml file is stored in the root folder. This protection information file contains the time stamp and the Windows user who enabled protection - that is either the user who enabled the path from the ChemStation Administration tool, or the user who configured a new instrument.

   The Protection Information file provides proof for a given folder when the last activation was performed. Any period of time before that date is unspecified. The file can be used to demonstrate the uninterrupted protection status of a folder since it contains the date, time and user who last enabled protection.

   Enabling or disabling secure file I/O is not logged to the OpenLab Control Panel Activity Log or the Windows Event Logs (application or Security).

   When the folder is unprotected, the ProtectionInfo.xml file is deleted. Note, deleting this file will not unprotect the folder.

6. For administrative tasks, you can temporarily disable the protection of specific folders:
   a. Shut down all ChemStation sessions.
   b. In the ChemStation Administration Tool, click **Manage Secure File System**.
   c. In the list of directories, find the relevant path and click **Unprotect**.
      The protection information file is deleted to document the interruption of the protection state.
   d. After finishing your tasks, click **Protect All** to restore protection for all relevant folders.
      New protection information files are created.
   e. Start ChemStation again.
      ChemStation will only start if all folders are protected.
Check privileges for Chemstation users

In the OpenLab Control Panel, specific privileges can be configured. Several privileges are relevant for Secure File I/O. They handle occasions when data, methods, or sequences need to be loaded from unprotected locations (which are outside of the secure folders). These privileges are enabled in the default ChemStation Roles to maintain the current workflows.

To ensure data integrity, it is recommended to uncheck these privileges when Secure File I/O is enabled.

The relevant privileges are:

- **ChemStation: Data > Load data from not configured path**
  Required for loading data from unprotected paths, or adding data paths that are not empty to the ChemStation.

- **ChemStation: Method > Load method from not configured path**
  Required for loading a method from an unprotected path, saving a method to an unprotected path, or adding method paths to the ChemStation (Preferences dialog).

- **ChemStation: Sequence > Load sequence template from not configured path**
  Required for loading sequence templates from unprotected paths, saving sequence templates to unprotected paths, or adding paths that are to the ChemStation (Preferences dialog).

**Important Notes for Working with Secure File I/O**

When using Secure File I/O to protect your ChemStation folders:

- Do not share protected folders. Sharing a folder will break the protection. If your data resides within the public documents folder (default setting), do not turn on public sharing.

- Do not log in interactively with the user account provided in the ChemStation Administration Tool.
  If this user logs in interactively, you will not be able to save any changed data in ChemStation until the user logs out again.

- If the password for this user account has expired, do not use the ChemStation until you updated the password in the ChemStation Administration Tool. ChemStation will not work properly as long as the password is outdated.
Limitations

The following features are not supported when Secure File I/O is enabled:

- Import/Export eMethods
- Migration of non-container data to new result sets
- Download files (method, sequence, data) using the content management web interface, and storing them to a protected folder
  These files must be downloaded from within the ChemStation application.
- GC Backflush Wizard
- G2887BA SIMDIS
- M8350AA MatchCompare
- M8370AA OpenLab Data Analysis Add-on
- Easy SamplePrep
- G7818A Cirrus GPC Software
- A2Prep software
- Method Scouting Wizard
- G4218A Evaporative Light Scattering Detector
Electronic Signature

Electronic signatures provide a means to sign documents as equally binding as a handwritten signature. In addition, electronic signatures are reproducible, because they are recorded in a secure, time stamped audit trail. Manipulation is prevented by enabling only users with specific privileges to sign electronically.

An electronic signature contains the user name (full name), date, and time when the signature was applied, the location where the signing occurred, and a user-configurable definition associated with the signature. The signature is always related to the complete result set, complete data file for a single run or to a report. The signature cannot be applied to a single file inside the SSIZIP file.

CFR 21 Part 11 requires that companies, especially ones that employ any type of approval process, use electronic signatures.

Preparation

Privileges

Users must have the **E-Signature Sign Files** privilege in order to be able to sign electronically.
Using electronic signatures

To apply an electronic signature in the Content Management system

1. In the Content Browser, navigate to the respective file. Move the mouse over the file name, and click the Sign File icon of this file.
   The Confirm Your Identity dialog opens.
2. Enter your login credentials for the Secure Workstation.
3. Select a reason for the signature from the Reason drop-down list.
   OR
   Select the reason Other, and enter a different reason into the text field.
4. Click OK.
   The file is now signed electronically. The e-signature is shown in the list of signatures under Version History.

To view electronic signatures in ChemStation

1. In the ChemStation Explorer, right-click the respective file.
2. Select CM Properties... from the context menu.
   This command is only available if the file has been uploaded to the data repository.
3. In the File Properties dialog, select the eSig tab.
   The electronic signature history for the file, including the date, signer's full name, and reason for each signature are listed.

To view electronic signatures in the Content Management system

1. Click on a file to preview its content.
2. Scroll down to see all document actions and properties.
   All e-signatures applied to a file are listed under Version History.
5

Filter and Search Options

Using the Advanced Search 96

This chapter provides an overview of the filter and search options for ChemStation data in the Content Management system.
ChemStation stores all result data in the ACAML format (ACAML = Agilent Common Analytical Markup Language), which results in .acaml files. There is one .acaml file for each sequence or single run. The .acaml files are always created when acquiring or reprocessing data. When the data is uploaded to the Content Management repository, the .acaml file is part of the SSIZIP file.

When using the advanced search in the Content Browser, you can limit your search to specific metadata based on the values given in the .acaml file.

1. In the top pane, click **Search**.
2. From the **Select field** drop-down list, select the field which you would like to use. You can use, for example, the following fields:
   - **Acquisition Batch > Acq Operator Name**
   - **Compound > Name**
   - **File > Name**
   - **Sample > Name**
   - **Sequence > Name**

The corresponding search expression is entered in the search field.

3. In the search field, type your search criteria.
4. Click **Search**.
6 Troubleshooting

Error messages at OpenLab Control Panel Startup 98
Alerts and Error Messages at ChemStation Startup 99
Content Management is not available after login 100
Error Messages in the Queue Management 101
Other Error Messages 103

The chapter gives some troubleshooting hints.
### Error messages at OpenLab Control Panel Startup

**Connection to Shared Services failed**

When OpenLab Shared Services are not available, the user cannot start the OpenLab Control Panel. As ChemStation is launched from OpenLab Control Panel, working with ChemStation is not possible.

When only the Content Management service is not available, the user can start OpenLab Control Panel and work with ChemStation, but he cannot transfer data to the data repository.

<table>
<thead>
<tr>
<th>Probable cause</th>
<th>Suggested actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1  The Content Management service is not available.</td>
<td>Contact your Content Management administrator. Start OpenLab Control Panel and work only with data in the ChemStation local file system.</td>
</tr>
<tr>
<td>2  OpenLab Shared Services are not available.</td>
<td>Ask your administrator to start OpenLab Shared Services.</td>
</tr>
</tbody>
</table>
Alerts and Error Messages at ChemStation Startup

Your Transfer Settings (Remote Data Path) differ from the current connection. Change Transfer Settings now?

At every startup, Agilent ChemStation checks whether all necessary information is provided for transferring data to the Content Management data repository. This message is shown if the information on the server provided in the Transfer Settings differs from the server configured in OpenLab Control Panel.

<table>
<thead>
<tr>
<th>Probable cause</th>
<th>Suggested actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 The Transfer Settings in ChemStation differ from the configuration in OpenLab Control Panel.</td>
<td>Make sure that the correct information on Account, and Path is provided in the Transfer Settings (CM &gt; Preferences &gt; Transfer Settings, click Get Server).</td>
</tr>
</tbody>
</table>
6 Troubleshooting

Content Management is not available after login

Content Management is not available after login

If Content Management should become unavailable after login to the OpenLab Control Panel, the user has already been authenticated. In this case, ChemStation knows the current logged-in user.

When Content Management becomes unavailable, ChemStation automatically tries to reestablish the user login.

The Load and Save functions are accessible, but an alert informs the user about the unavailability of the Content Management system.

While acquiring data, the automatic transfer of data to the data repository cannot be completed. The user is notified by an error message and must manually resume the queue to upload the data as soon as the connection is reestablished (CM > Manage Queue).

As soon as Content Management is available again, all tasks are available without restarting the application. A new login is not required.

For further troubleshooting, please contact the administrator for Content Management.
## Error Messages in the Queue Management

### The queue already contains items

<table>
<thead>
<tr>
<th>Probable cause</th>
<th>Suggested actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 There are items in the queue that have been queued before the current item.</td>
<td>Process queue in the correct order. If necessary, export items that can’t be resolved.</td>
</tr>
</tbody>
</table>

### Invalid URI: The format of the URI could not be determined

<table>
<thead>
<tr>
<th>Probable cause</th>
<th>Suggested actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 In the preferences, the Content Management server is missing or has been entered by name only, not as URI (syntax http:\servername).</td>
<td>Correct the server in the preferences, e.g. by using Get Server. Save existing items in the queue to the local file system. After correcting the server setting, reprocess the data.</td>
</tr>
</tbody>
</table>

### No connection to remote storage established

<table>
<thead>
<tr>
<th>Probable cause</th>
<th>Suggested actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 The Content Management service is not available.</td>
<td>Contact your Content Management administrator.</td>
</tr>
</tbody>
</table>

### Connection to remote storage is broken

<table>
<thead>
<tr>
<th>Probable cause</th>
<th>Suggested actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Content Management has become unavailable during the current session.</td>
<td>Contact your Content Management administrator.</td>
</tr>
</tbody>
</table>
### You cannot upload a file that is checked out by another user

<table>
<thead>
<tr>
<th>Probable cause</th>
<th>Suggested actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 The file you want to upload is currently checked out by another user.</td>
<td>Ask the other user to check in the file, then upload again.</td>
</tr>
</tbody>
</table>

### You do not have appropriate permissions to create a folder

<table>
<thead>
<tr>
<th>Probable cause</th>
<th>Suggested actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 You do not have the privilege to create content in the Content Management system.</td>
<td>Ask your administrator to give you the Save data to storage privilege.</td>
</tr>
</tbody>
</table>
Other Error Messages

Access to the path `<local ChemStation path>` is denied.

Probable cause

1. ChemStation folders are protected by Secure File I/O, and the password for the Secure File I/O user has expired.

Suggested actions

- Shut down the ChemStation. Update the password for the Secure File I/O user account. Provide the new password in the ChemStation Administration Tool. Then start the ChemStation again.
- See the chapter about `Folder Protection with Secure File I/O` in the OpenLab CDS ChemStation Edition Guide for Administrators.
6 Troubleshooting
   Other Error Messages
7

Appendix

Privileges in OpenLab Control Panel 106
Project Privileges 107
Instrument Privileges 111
Administrative Privileges 112
Privileges in OpenLab Control Panel

The privileges described in the following are associated with different roles in OpenLab Control Panel. By default, the following roles are available:

- Everything
- System Administrator
- Instrument Administrator
- Project Administrator
- Instrument User
- Archivist
- Content Management Approver
- Content Management Contributor
- Content Management Reader
- ChemStation Administrator
- ChemStation Lab Manager
- ChemStation Analyst
- ChemStation Operator

In OpenLab Control Panel under Administration > Roles, you can view or change the associated privileges, or create your own roles.
## Project Privileges

### Table 10  Project Management

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View project or project group</td>
<td>User can view the content of the Content Management repository.</td>
</tr>
<tr>
<td></td>
<td><em>Note:</em> This privilege is required for all users.</td>
</tr>
<tr>
<td>Edit content of project</td>
<td>User can create new versions of documents in the Content Management system.</td>
</tr>
<tr>
<td>Manage project or project group</td>
<td>User can create, edit, or move projects but cannot access settings.</td>
</tr>
<tr>
<td>Manage project or project group access</td>
<td>User can edit project access settings</td>
</tr>
<tr>
<td>Access content using web client</td>
<td>User with this privilege is able to open the Content Browser interface.</td>
</tr>
</tbody>
</table>

### Table 11  E-Signature

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-Signature Sign Data Files</td>
<td>User can sign data files.</td>
</tr>
</tbody>
</table>

### Table 12  ChemStation: Control

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Acquisition</td>
<td>Start acquisition (single sample or sequence).</td>
</tr>
</tbody>
</table>
### Privileges in OpenLab Control Panel

#### Table 13  ChemStation: Data

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Data</td>
<td>User can delete data files in the navigation table.</td>
</tr>
<tr>
<td>Load data using not configured path</td>
<td>If Secure File IO is enabled, this privilege is required to:</td>
</tr>
<tr>
<td></td>
<td>• load data from unprotected paths</td>
</tr>
<tr>
<td></td>
<td>• add paths that are not empty to the ChemStation (Preferences dialog)</td>
</tr>
<tr>
<td>Manual Integration</td>
<td>User can perform manual integration.</td>
</tr>
<tr>
<td>Save data to storage</td>
<td>Interactive saving of data to the Content Management data repository.</td>
</tr>
</tbody>
</table>

#### Table 14  ChemStation: Instrument

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify instrument configuration</td>
<td>User can modify the instrument configuration parameters.</td>
</tr>
</tbody>
</table>

#### Table 15  ChemStation: Logbook

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear Logbook</td>
<td>Clear the current logbook.</td>
</tr>
<tr>
<td>Save Logbook</td>
<td>Save the current logbook.</td>
</tr>
</tbody>
</table>
### Privileges in OpenLab Control Panel

#### Table 16 ChemStation: Method

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit calibration table</td>
<td>Create and modify the calibration table; change calibration settings.</td>
</tr>
<tr>
<td>Delete method</td>
<td>Delete a master method from the disk through the file menu.</td>
</tr>
<tr>
<td>Edit integration events</td>
<td>Modify integration events and perform Auto Integration.</td>
</tr>
<tr>
<td>Edit ion labels</td>
<td>Edit options for ion labels (LC/MS only).</td>
</tr>
<tr>
<td>Edit system suitability</td>
<td>Edit noise ranges and performance limits.</td>
</tr>
<tr>
<td>Enable audit trail</td>
<td>Enable the audit trail for a specific method.</td>
</tr>
</tbody>
</table>
| Load method from not configured path   | If Secure File IO is enabled, this privilege is required for ...
  * loading a method from an unprotected path
  * saving a method to an unprotected path
  * adding paths that are not empty (Preferences dialog)                                             |
| Modify instrument method               | Modify instrument method parameters.                                                                                                          |
| Modify method properties               | Modify Run Time Checklist and Method Information.                                                                                              |
| Perform method recalibration           | Perform interactive recalibration.                                                                                                             |
| Save method changes                    | Save method changes (includes Update Sequence/Master Method in Data Analysis view).                                                            |

#### Table 17 ChemStation: Report

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview/print report</td>
<td>User can preview/print a report.</td>
</tr>
<tr>
<td>Modify report</td>
<td>User can modify report calculation/print style and can edit Instrument Curves dialog.</td>
</tr>
<tr>
<td>Lock/unlock report template items</td>
<td>Only relevant with Intelligent Reporting: User can lock or unlock report items and composite groups in a report template.</td>
</tr>
</tbody>
</table>
## Privileges in OpenLab Control Panel

### Table 18  ChemStation: Security

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Break session lock</td>
<td>Unlock a ChemStation session locked by other users.</td>
</tr>
<tr>
<td>Command line</td>
<td>Turn on / off the command line</td>
</tr>
<tr>
<td>Manage transfer queue</td>
<td>Access to the Transfer Queue and the Queue Management.</td>
</tr>
<tr>
<td>Modify storage transfer preferences</td>
<td>Modify transfer settings for data upload to the Content Management repository.</td>
</tr>
</tbody>
</table>

### Table 19  ChemStation: Sequence

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change priority in run queue</td>
<td>User can submit samples or sequences to the front of the queue, and change the order of items in the run queue.</td>
</tr>
<tr>
<td>Delete entries from run queue</td>
<td>User can remove queued samples or sequences from the run queue.</td>
</tr>
<tr>
<td>Delete sequence</td>
<td>User can delete the classic sequence templates from disk through the file menu.</td>
</tr>
<tr>
<td>Edit sequence summary</td>
<td>User can modify sequence summary report and extended statistics settings.</td>
</tr>
</tbody>
</table>
| Load sequence template from not configured path | If Secure File I/O is enabled, this privilege is required to ...  
  • load sequence templates from unprotected paths  
  • save sequence templates to unprotected paths  
  • add paths that are not empty to the ChemStation (Preferences dialog) |
| Reprocess                          | User can reprocess a sequence.                                              |
| Save sequence template             | User can save sequence templates locally.                                  |
Appendix

Privileges in OpenLab Control Panel

Table 20  ChemStation: View Access

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Data Analysis view</td>
<td>User has access to Data Analysis view.</td>
</tr>
<tr>
<td>Access Diagnostic view</td>
<td>User has access to Diagnostic view.</td>
</tr>
<tr>
<td>Access Method &amp; Run Control view</td>
<td>User has access to Method and Run Control view.</td>
</tr>
<tr>
<td>Access retention time lock</td>
<td>User has access to the Retention Time Lock menu (GC only).</td>
</tr>
<tr>
<td>Access retention time search</td>
<td>User has access to Retention Time Search menu (GC only).</td>
</tr>
<tr>
<td>Access Review view</td>
<td>User has access to Review view.</td>
</tr>
<tr>
<td>Access Tune view</td>
<td>User has access to Tune view (LC-MSD ChemStation only).</td>
</tr>
<tr>
<td>Access Verification view</td>
<td>User has access to Verification (OQ/PV) view.</td>
</tr>
<tr>
<td>Access Report Layout view</td>
<td>User has access to Report Layout View, ability to create/edit/save report templates.</td>
</tr>
<tr>
<td>Enable Batch view</td>
<td>Enables all operations in Batch view.</td>
</tr>
</tbody>
</table>

Instrument Privileges

Table 21  Instrument Management

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View instrument or location</td>
<td>User can view and access a location in the tree, but not edit access security, can view properties.</td>
</tr>
<tr>
<td>Manage Instrument or location</td>
<td>User can create and move locations and edit properties (name, description, etc).</td>
</tr>
<tr>
<td>Manage instrument or location access</td>
<td>User can view and edit the location access settings.</td>
</tr>
<tr>
<td>Run instrument</td>
<td>User can start an instrument session.</td>
</tr>
<tr>
<td>Service instrument</td>
<td>User can lock or unlock an instrument (to service it).</td>
</tr>
</tbody>
</table>
Appendix
Privileges in OpenLab Control Panel

## Administrative Privileges

### Table 22 System Administration

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage printers</td>
<td>Can add/remove printers and print server.</td>
</tr>
<tr>
<td>Edit activity log properties</td>
<td>Can change the Activity log Settings in OpenLab Control Panel (that is, can turn logging on for the System Activity Log).</td>
</tr>
<tr>
<td>Create administrative reports</td>
<td>Can create any of the system admin reports.</td>
</tr>
<tr>
<td>Manage system components</td>
<td>Can install/remove components (applications).</td>
</tr>
</tbody>
</table>
| Manage Security               | Can change security settings. Can edit (add, change etc) users, groups and roles.  
**Note:** A user with this privilege can grant himself access to all settings in Secure Workstation for OpenLab CDS ChemStation Edition. Be careful who you grant the Manage Security privilege. |
| Manage instrument controllers | Can edit workstation configuration.                                         |
| Unlock any locked UI          | Can login into any locked portal or instrument session (will be a re-login), even if privately locked. |

### Table 23 Content Management

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archive content</td>
<td>User can archive the content of the data repository.</td>
</tr>
</tbody>
</table>
In This Book

Secure Workstation for OpenLab CDS ChemStation Edition is a standalone workstation product that includes OpenLab CDS ChemStation Edition and OpenLab Server on a single computer. This guide contains information on working with C.01.09. It describes the settings required by 21 CFR Part 11, and provides information on the workflows using the Secure Workstation.